By opening the disk envelope, you agree to the terms and conditions of the following license agreement. If you do not agree with the following terms and conditions, return the unopened disk envelope and package to place of purchase for a full refund. Bungie Software ("BUNGIE") is the owner of the software contained in the disk envelope. You are being granted a non-exclusive right to use the program within the disk envelope under the terms set out below.

**Permitted Uses:** You may use the software on a single computer at any one time. You may physically transfer the program from one computer to another, provided that the software is used only at one computer at a time. You may sell or give the software to another party, provided that the other party agrees to be bound by the terms of this License Agreement. You may make one copy of the program solely for backup purposes. The copyright and other notices on the diskette must be reproduced and placed on the backup copy.

**Prohibited Uses:** You may not make more than one backup copy as permitted above. If you should wish to copy or use the software on more than one computer at the same time, contact BUNGIE. You may not distribute, lease, rent, sublicense or loan the software or documentation to any other person. You may not electronically transfer the software from one computer to another computer or provide use of the software in a computer service business, network, time-sharing, or multiple-use agreement. You may not modify, translate, or reverse engineer the software.

**Term:** You may terminate this license agreement by destroying the software and documentation and any copies. This license will also terminate if you fail to comply with any term or condition of this agreement. Upon termination, you agree to destroy all copies of the program and documentation.

**Limited Warranty on Software Materials and Media:** BUNGIE warrants that the manual and the software media are free from defects in materials and faulty workmanship under normal use for a period of ninety days from the date of original purchase. In the event of any physical defects in the software media during the ninety days after purchase, BUNGIE will replace the software media at no charge to the original purchaser after proof of purchase. If the failure of the software media, in the judgement of BUNGIE results from accident, abuse or misapplication of the media, BUNGIE will have no responsibility to replace the media under this warranty. **ALL IMPLIED WARRANTIES ON THE SOFTWARE MEDIA, INCLUDING IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF ORIGINAL RETAIL PURCHASE.** The manual and the software are sold "AS IS." The purchaser assumes all risk as to its quality and performance. In no event will BUNGIE be held liable for direct, indirect, special, incidental, or consequential damages resulting from any defect in the software, the media, or its documentation. Your sole and exclusive remedy in the event of defect in the media is replacement as provided above. The above warranty and remedies are exclusive and in lieu of all others, whether oral, written, express or implied. No employee, dealer, or agent is authorized to make any modification, extension, or addition to this warranty. Certain states do not allow the exclusion or limitation of incidental or consequential damages, so the above limitation may not apply to you. BUNGIE retains all rights not expressly granted. Nothing under this agreement constitutes a waiver of BUNGIE's rights under the U.S. Copyright Laws or any other state or federal law.

This manual and the software accompanying it are copyrighted with all rights reserved. Neither the manual or the software may be copied, in whole or in part, without written consent of Bungie Software, except in the normal use of the software as provided by the U.S. Copyright Law or to make a single backup copy. The backup copy may not be sold or given to another person except as part of a set that includes the original copy. Macintosh is a registered trademark of Apple Computer, Inc.

© 1991 Bungie Software
Welcome to Operation: Desert Storm! In this game, you command an M1A1 Abrams tank on a series of twenty missions in the Kuwaiti Theater of Operations. Your objectives include the destruction of Iraqi nuclear plants and chemical warfare facilities, the elimination of SCUD missile launchers, and more. Arrayed against you will be a formidable combination of enemy tanks, aircraft, land mines, poison gas and artillery. You’ll have to think and respond quickly to get the job done and bring your crew home!

Also included in this game is information regarding the geography and peoples of the region, their industrial and energy resources, the types of weapons used in the conflict, and an analysis of the actual battlefield maneuvers which brought victory to the Allied nations on February 27, 1991. We hope that this information will broaden your understanding of the conflict, the region, and its people.

This manual assumes that you have read Macintosh, the Macintosh owner’s manual. You should know how to point, click, open applications from the Finder, and choose commands.

To play Operation: Desert Storm, you must use System 6.0 or higher on a Macintosh Plus, SE, Classic, LC, SE/30 or a member of the Macintosh II family.

You may transfer the Operation: Desert Storm folder to your hard disk, but make sure the Logistics file remains in the same folder as the Desert Storm Application.

You may not change the name of the 'Logistics' file or put it in a different folder than the application; doing so will result in an error.

You may remove the 'NewsSounds' file to save space, but you will no longer get war coverage updates when running the application.

Also, Operation: Desert Storm may be hindered if your system has many INITs installed. If this happens, you can disable the INITs by holding the shift key down during your computer’s start up cycle.
Enlisting in the Allied Forces

- Open the Desert Storm application from the Finder.
- Choose the Enlist command from the File menu to receive your first mission briefing.

The Mission Briefing screen appears.

The Briefing screen contains a message box, a map of the local area of operations (lower left), and a map of the Middle East (lower right). The message box tells you the location and objective of the mission. It also displays the coordinates of your release and extraction. If you click on the Map of the Middle East, it will change to a map of the Kuwaiti Theater of Operations.

You can find out where the extraction coordinates are by moving the pointer over the mission map. The coordinates are displayed in the lower right box. You can also determine the identity of the battlefield objects by pointing at them; a description appears in the lower left box.

Clicking the Print Map button prints the current mission’s map. Clicking the Go AWOL button returns you to the title screen.

- Click the Charge! button to begin your mission!

Warplan Summary:

- To start, you must enlist in the Allied forces.
- Each mission begins when you are dropped off, or “released” in the Theater of Operations.
- You must then proceed to the objectives and attempt to destroy or disable them.
- Then you must proceed to the pickup, or “extraction” points.
- If you are successful, you will advance to the next mission. If you complete all twenty missions, victory is yours!
Beginning a Mission

When the mission begins, you are released by an Armored Transport Delivery Vehicle. You will have to meet the same vehicle at the designated time and place to complete the mission. When ready, hit any key to exit the delivery vehicle.

Armored Transport Delivery Vehicle

To board, drive into the mouth of the vehicle.

Operating the M1A1 Abrams Tank

There are five movement controls for your tank: Forward, Reverse, Stop, Left, and Right. Initially, they are configured for numeric keypad users (keys 8, 2, 5, 4 and 6, respectively). Additional controls include a “fire” key for your 120mm cannon (Spacebar), a TOW missile launch key (B), and a key to put on or take off your gas protection equipment (G). You can pause and resume at anytime with the P key, and you can self-destruct with the Q key. To change this configuration, choose the Keyboard Setup command from the Options menu.

Your tank cannot fire the cannon or launch TOW missiles while the gas protection is on.

Your tank is equipped with an Overdrive mechanism, which may be engaged by holding down the Shift key while hitting the Forward key. Overdrive is disengaged when another key, such as Stop, is hit. Be careful, though: the Overdrive mode uses fuel less efficiently and makes you more vulnerable to land mines.

Largest Armed Forces in 1988

<table>
<thead>
<tr>
<th></th>
<th>Actives</th>
<th>Reserves</th>
</tr>
</thead>
<tbody>
<tr>
<td>USSR</td>
<td>5,100,000</td>
<td>6,200,000</td>
</tr>
<tr>
<td>China</td>
<td>3,200,000</td>
<td>1,200,000</td>
</tr>
<tr>
<td>United States</td>
<td>2,165,000</td>
<td>1,676,000</td>
</tr>
<tr>
<td>India</td>
<td>1,365,000</td>
<td>250,000</td>
</tr>
<tr>
<td>Iraq</td>
<td>1,000,000</td>
<td>650,000</td>
</tr>
<tr>
<td>North Korea</td>
<td>842,000</td>
<td>540,000</td>
</tr>
</tbody>
</table>

You will lose a tank if you:
- Are shot by the enemy.
- Collide with the enemy’s equipment.
- Enter poison gas without wearing gas protection gear.
- Hit a land mine.
- Run out of fuel. To replenish your fuel, look for extra fuel pods (shown below) on the battlefield which were pre-positioned by the Special Forces Unit.

The M1A1 TOW Missile Extra Fuel

On the right side of the screen is your instrument panel:

- Score
- Fuel Level
- Missile Supply
- Mine Indicator
- Gas Protection Indicator
- Current Time
- Current Coordinates
- Extraction Time
- Extraction Coordinates
- Strength Indicator
- Tanks Remaining

You may carry up to eight TOW missiles.

The Mine Indicator alerts you whenever you approach a mine. If this happens, you should stop and back up.

The Strength Indicator tells you how many hits your armor will absorb. A heavier border indicates a stronger tank. Your armor strength will increase as you complete missions.

- The Ba’ath Party came to power in Iraq in 1968 and has been led since 1979 by Saddam Hussein.
- In 1981, Israeli war planes destroyed an Iraqi nuclear plant near Baghdad.
Scoring

For destroying enemy equipment, you will receive the following points:

- T-55 Iraqi Battle Tank: 75 Points
- T-62 Iraqi Battle Tank with 115mm cannon: 150 Points
- T-72 Soviet-built Tank with 125mm cannon: 300 Points
- G-5 Howitzer - 155mm gun with 24 mile range: 75 Points
- Multidirectional Gunner Stations: 5-8 105mm cannons: 150 Points
- Mi-24 Hind - Soviet Helicopter with Gatling Guns and antitank missiles: 250 Points
- MiG-29 Fulcrum - Soviet-built fighter with ground attack bombs: 350 Points
- Mirage F-1 - French-built fighter with laser-guided weapons: 350 Points

You also receive points for picking up POWS and Spoils. Your score is credited for these items at the end of the mission.

- Iraqi Pow: 75 Points
- Spoils: 50 Points

Your score is also credited at the end of the mission for destroying the following strategic targets:

- Command & Control Center
  - 500 Points
- Chemical Weapons Plant
  - 500 Points
- Army Bunker
  - 500 Points
- Weapons Depot
  - 500 Points
- SCUD Missile Launcher
  - 500 Points
- Nuclear Facility
  - 500 Points
- Oil Storage Depot
  - 500 Points

### Military Spending in 1988

<table>
<thead>
<tr>
<th>Country</th>
<th>1985 dollars</th>
<th>Percent of GNP</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States</td>
<td>260,000,000,000</td>
<td>6.4</td>
</tr>
<tr>
<td>USSR</td>
<td>-</td>
<td>est. 9.0 - 11.0</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>22,000,000,000</td>
<td>4.7</td>
</tr>
<tr>
<td>West Germany</td>
<td>21,000,000,000</td>
<td>3.0</td>
</tr>
<tr>
<td>France</td>
<td>21,000,000,000</td>
<td>4.0</td>
</tr>
<tr>
<td>Japan</td>
<td>15,250,000,000</td>
<td>1.0</td>
</tr>
<tr>
<td>Saudi Arabia</td>
<td>14,500,000,000</td>
<td>22.7</td>
</tr>
<tr>
<td>Italy</td>
<td>11,000,000,000</td>
<td>2.4</td>
</tr>
<tr>
<td>India</td>
<td>8,250,000,000</td>
<td>3.8</td>
</tr>
<tr>
<td>Canada</td>
<td>8,000,000,000</td>
<td>2.1</td>
</tr>
<tr>
<td>Iraq</td>
<td>7,000,000,000</td>
<td>26.8</td>
</tr>
<tr>
<td>South Korea</td>
<td>6,250,000,000</td>
<td>5.7</td>
</tr>
<tr>
<td>China</td>
<td>5,300,000,000</td>
<td>1.9</td>
</tr>
<tr>
<td>North Korea</td>
<td>4,000,000,000</td>
<td>9.3</td>
</tr>
</tbody>
</table>
Completing the Mission

After completing the objective of the mission, you must proceed to the extraction location to meet the Armored Assault Transport Vehicle. The extraction coordinates are given in the instrument panel below the current coordinates. (See page 5)

If you are more than 30 seconds late for extraction, a penalty is assessed. The penalty increases with time. If you lose your bearings, you may display the mission map with Command-M.

After extraction, the Damage Assessment screen is displayed.

```
CENTCOM: DAMAGE ASSESSMENT BRIEFING:

POINTS SCORED: COMMAND
POWS CAPTURED: 3 3 3 3 3
ASSETS SIZED: 3 3 3 3 3
TARGETS DESTROYED: 3 3
LATE FOR EXTRACTION: 3 3

MEDALS AWARDED:
TOTAL SCORE: 3 3 3
RANK: COLONEL

Save  Save As... End Game Next Mission
```

At this point, your score is credited for spoils, POWS, and strategic targets. Late penalties are also assessed. Your rank is given at the bottom of the screen:

<table>
<thead>
<tr>
<th>Points Range</th>
<th>Rank</th>
<th>Score Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-5,000</td>
<td>Private</td>
<td>20,000-25,000</td>
</tr>
<tr>
<td>5,000-10,000</td>
<td>Corporal</td>
<td>25,000-30,000</td>
</tr>
<tr>
<td>10,000-15,00</td>
<td>Sergeant</td>
<td>30,000-40,000</td>
</tr>
<tr>
<td>15,000-20,000</td>
<td>Lieutenant</td>
<td>&gt; 40,000 points</td>
</tr>
</tbody>
</table>

Saving the Game

While reviewing the Damage Assessment screen, you may save the current game by clicking the Save button in the lower left corner of the screen. You may not save during the missions. If you want to save a different copy of the game, click the Save As button and rename the current game.

The Next Mission

To proceed to the next mission, click the Next Mission button on the Damage Assessment screen. Complete all twenty missions to win the war!

Practicing a Mission

You can practice the first nineteen missions by choosing the Practice command from the File menu. You may make yourself immortal during practice by choosing the Practice Immortality command from the Options menu. While practicing, your score is not saved, and you may not progress between levels.

### World Crude Oil Production in 1988
(millions of barrels per day)

<table>
<thead>
<tr>
<th>Country</th>
<th>Production</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>USSR</td>
<td>11.68</td>
<td>20</td>
</tr>
<tr>
<td>United States</td>
<td>8.14</td>
<td>14</td>
</tr>
<tr>
<td>Saudi Arabia</td>
<td>5.29</td>
<td>9</td>
</tr>
<tr>
<td>China</td>
<td>2.73</td>
<td>5</td>
</tr>
<tr>
<td>Iraq</td>
<td>2.65</td>
<td>5</td>
</tr>
<tr>
<td>Mexico</td>
<td>2.51</td>
<td>4</td>
</tr>
<tr>
<td>Iran</td>
<td>2.26</td>
<td>4</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>2.23</td>
<td>4</td>
</tr>
<tr>
<td>Venezuela</td>
<td>1.90</td>
<td>3</td>
</tr>
<tr>
<td>Canada</td>
<td>1.61</td>
<td>3</td>
</tr>
<tr>
<td>Nigeria</td>
<td>1.44</td>
<td>2</td>
</tr>
<tr>
<td>Indonesia</td>
<td>1.28</td>
<td>2</td>
</tr>
<tr>
<td>Other OPEC</td>
<td>5.87</td>
<td>10</td>
</tr>
<tr>
<td>Other Non-OPEC</td>
<td>8.69</td>
<td>15</td>
</tr>
<tr>
<td>World Total</td>
<td>58.28</td>
<td>100</td>
</tr>
</tbody>
</table>
Reference

File menu

Enlist
Starts a new game. Choose this command to receive your first mission briefing.

Practice
Allows you to practice any mission. While in Practice mode, your high scores will not be saved, and you may not advance to the next level.

Open
Opens a saved game file.

Quit
Allows you to quit Desert Storm and returns you to the Finder.

Brief History of Islam

- Islam is the second largest world religion after Christianity.
- Mohammed, the Prophet, was born in Mecca circa 570 A.D. He died in 632.
- The holiest month of the Islamic calendar is called Ramadan. It marks the month during which the central text of Islam, the Koran, was revealed to Mohammed. Ramadan is observed by fasting between sunrise and sunset.
- The Hadith is a sacred text of Islam that contains the sayings of Mohammed.
- The Koran was revealed to Mohammed by the angel Gabriel.
- The holiest day of the week for Moslems is Friday.
- The two holiest cities for Moslems are Mecca and Medina.
- The first two caliphs (successive rulers) of Islam were Abu Bakr (632-634) and Oman (634-644).

Options menu

Instructions
Displays instructions for operating the tank and completing the missions. Click on the Forward and Backward arrows to see more information.

Keyboard Setup
Used to change the keyboard setup. The Set Default button makes the current setup the default. The Load Original Set button returns the Keyboard Setup to its original numeric keypad configuration.

Sound
Turns the game sounds on and off.

Show/Hide High Scores
Shows and hides the High Scores at the title screen.

Clear High Scores
Erases the current high scores.

Practice Immortality
Choose this command to give yourself an unlimited number of lives during a practice level.

Specs menu

Combat Specs
Displays information about the enemy’s equipment.

Middle East Countries
Displays facts about the countries in the region. Click on the Forward and Backward arrows to see more information

- The modern states of the Middle East were formerly part of the Ottoman Empire.
- The Kuwaiti royal family was established by the forces of Great Britain.
In one of the most impressive strategic manoeuvres in military history, the Allies swung around Kuwait from the west and encircled the Iraqi armed forces within the newly defined KTO. General Colin Powell proclaimed, "We are going to cut it off and then we are going to kill it," and that is exactly what they did. The Allies bluffed a massive Marine amphibious assault. While Saddam amassed his troops in Kuwait, the Allies completed the destruction of his communications network. Blind and confused, his troops were easily sealed within Kuwait. Hussein's already dwindling military options became twofold: Surrender or face an attack from all fronts. The outcome is now in the realm of history....
American War History

**Revolutionary War**
- April 19, 1775 - Sept. 3, 1783
- 10,800 American Casualties
- Fought against Britain for Independence.

**War of 1812**
- June 18, 1812 - Dec. 24, 1815
- 7,100 American Casualties
- Fought against Britain for free trade and sea passage.

**Mexican War**
- May 13, 1846 - Feb. 21, 1848
- 5,900 American Casualties
- Fought against Mexico over land disputes.

**Civil War**
- April 12, 1861 - April 9, 1865
- 646,400 American Casualties
- Fought between Union and Confederate forces.

**Spanish-American War**
- April 25, 1898 - Dec. 10, 1898
- 4,100 American Casualties
- Fought against Spain over the sovereignty of Cuba.

**World War I**
- April 6, 1917 - Nov. 11, 1918
- 364,500 American Casualties
- Fought against Germany, Austria, and Hungary.

**World War II**
- Dec. 7, 1941 - Dec. 31, 1946
- 1,076,250 American Casualties
- Fought against Axis Powers (Germany, Italy, and Japan).

**Korean War**
- June 25, 1950 - July 27, 1953
- 157,530 American Casualties
- Fought against North Korea.

**Vietnam**
- 211,438 American Casualties
- Fought against North Vietnam.

**Persian Gulf War**
- 445 American Casualties
- Fought against Iraq over liberation of Kuwait.

---

**Timeline**

- **1914-18** World War I: Ottoman Empire is dismembered.
- **1917** British occupy Palestine and issue Balfour Declaration supporting Jewish homeland there.
- **1918** British occupy territory which becomes Iraq. Iraq becomes a League of Nations mandate after the war.
- **1920** Syria and Lebanon become a French League of Nations mandate.
- **1921** Iraq established as a kingdom under Faisal I. The British maintain military bases.
- **1921-22** Military coup in Iran ends British rule. Palestine becomes British League of Nations Protectorate.
- **1923** Transjordan (now Jordan) is created by partition of Palestine.
- **1930** Nazism and persecution of Jews in Europe increases flow of Jewish immigrants to Palestine. Friction between Arabs and Jews in Palestine increases.
- **1932** Saudi Arabia is created with Ibn Saud as king.
- **1936** Oil is found in Saudi Arabia.
- **1941** Muhammed Reza Shah Pahlavi begins reign in Iran which lasts until 1979. Rapid modernization program begins.
- **1944** Syria becomes independent.
- **1945** Arab League founded.
- **1946** Jordan becomes an independent kingdom.
- **1948** Israel is created in Palestine as a national homeland for Jews.
- **1951** Libya gains independence.
- **1953** Egyptian republic is established following anti-British unrest. British withdraw troops in 1954.
- **1956** Suez Crisis. Egypt's Nasser nationalizes canal, bringing about invasion by Britain, France and Israel.
- **1958** Iraq becomes a republic.
- **1960** OPEC founded to regulate oil production.
- **1963** Military rule in Iraq.
- **1964** Palestinian Liberation Organization founded by Palestinian refugees.
- **1967** Third Arab-Israeli War (The Six-Day War). Israel captures Sinai, the West Bank, the Golan Heights, and the Old City of Jerusalem.
- **1973** Fourth Arab-Israeli War (Yom Kippur War). Egypt, Syria and Iraq attack Israel on Jewish holy day and are beat back. Arab oil embargo begins, and OPEC causes massive oil price hike.
- **1975** Kurdish revolt in northern Iraq is crushed.
- **1975** Lebanese civil war begins, with Muslim factions rebelling against the Christian government. Syria invades.
- **1978-79** Fundamentalist revolution in Iran. Shah is ousted by followers of Ayatollah Khomeini.
- **1979** Egypt's Anwar Sadat signs peace treaty with Israel in exchange for Israeli pullout from Sinai peninsula.
- **1979-81** United States embassy personnel are held hostage in Iran by Khomeini supporters.
- **1981** President Sadat is assassinated in Egypt.
- **1982** Israel invades Lebanon to remove PLO militia.
- **1983-84** U.S. peacekeeping force stationed in Beirut. 239 Marines killed by a truck bomb.
- **1986** United States launches air strike against Tripoli, Libya in response to Libyan sponsorship of terrorists.
- **1986** United States admits to secret arms sales to Iran.
- **1987** United States frigate Stark is hit by Iraqi missile in the Persian Gulf; 37 sailors killed.
- **1988** U.S. Navy warship shoots down Iranian jetliner, killing 290.
- **1988** United Nations-sponsored cease fire begins in Iran-Iraq war.
- **1988** The PLO issues statement renouncing terrorism and recognizing Israel's right to exist.
- **1989** Iran's Ayatollah Khomeini dies.
- **1990** Iraq invades Kuwait and threatens invasion of Saudi Arabia.
Glossary

A-6E  Intruder: Carrier based long range bomber
A-10  Thunderbolt: Battlefield support jet
ACCHAN  Allied Command Channel
ACE  Allied Command Europe
ACLANT  Allied Command Atlantic
AFSOUTH  Allied Forces Southern Europe
AH-1W  Sea Cobra: Attack helicopter
AH-64  Apache: Battlefield helicopter
AV-8B  Harrier: Ground support jet
AWACS  Airborne Warning and Control System
B-52  Stratofortress: Long Range Bomber
CBR  Chemical, Biological, or Radiological agents used as weapons
CENTAG  Central Army Group
CENTCOM  U.S. Central Command headed by H. Norman Schwarzkopf
CENTO  Central Treaty Organization
F-4G  Wild Weasel: Tactical bomber
F-14  Tomcat: Air to Air fighter
F-15  Eagle: Long range fighter
F-16  Falcon: Air combat fighter - Attack jet
F-111  Aardvark: Long range tactical fighter-bomber
F-117A  Stealth: Tactical fighter
F/A-18  Hornet: Carrier based fighter
LAV  Light Armored Vehicle
M-60  Marine Corps Battle Tank
M1A1  Abrams: US Main Battle Tank
M2  Bradley: Light Armored Fighting Vehicle
MLRS  Multiple Launch Rocket System
NADGE  NATO Air Defense System
NATO  North Atlantic Treaty Organization
NORAD  North American Air Defense Command
Patriot  American Anti-Ballistic Missile
SAC  Strategic Air Command
SACEUR  Supreme Allied Commander Europe
SALT  Strategic Arms Limitation Talks
SAMOS  Satellite and Missile Observation System
SCUD  Soviet Tactical Missile
SEATO  South East Asia Treaty Organization
SHAPE  Supreme Headquarters Allied Powers in Europe
Tomahawk  Computer Guided Cruise Missile
TOW  Tube Launched, Optically Tracked, Wire Guided anti-tank missile system.

Further Reading


